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Welcome to Horizons Technology’s Open!Info Manager Demonstration 
Program!  Included with this demonstration program is a multimedia 
presentation authored with Open!Info Manager that provides insight 
into the capabilities of multimedia presentations and their most 
common uses.  In addition, we’ve included step-by-step instructions
for creating a simple presentation.  

The instructions for running the presentation and creating your own
Open!Info presentation begin after a few words about installation 
and video drivers.  Simply select Print from the File menu so you 
can have the instructions at hand, double-click the Open!Info 
Manager icon, and have fun!

Please call us at 1-800-828-3808 if you'd like to purchase or learn
more about Open!Info Manager.

A Few Notes On Installation:
For best results, please set your display setting in a 16-bit color
mode (32,768 or more colors).  This can be done by selecting the 
icon created during installation of your video drivers.  If the 
video driver installation did not create an icon, select the 
Windows Setup icon in the Main Program Group and choose the Change 
System Settings from the Options menu.

Open!Info Manager, as well as other multimedia programs, will 
provide the best possible display of digital video in this setting.

A Few Notes on Video Drivers:
Open!Info Manager has been tested using a wide variety of sound and
video cards.  Horizons Technology is committed to supporting 
emerging standards, as well as the most popular multimedia hardware
cards.  If you experience any problems displaying video using Open!
Info Manager, please verify you have the latest video drivers 
supplied by your card manufacturer.

Open!Info Manager
Test Drive Tutorial

Test drive this Open!Info Manager Demonstration Version by previewing 
the demo presentation and creating a presentation on your own. You'll 
see the many features built into Open!Info Manager to help you create 
exciting and effective multimedia presentations. 

Before you begin, take note of the following File menu commands that 
have been disabled in this Demonstration Version.



1.  Delete
2.  Save
3.  Save As
4.  Close
5.  Publish
6.  Create Backup
7.  Load Backup
8.  Clear All

Also, changes to the database are not saved when you exit Open!Info 
Manager.  Commands like Import Media and Delete Page function normally 
while you working in Open!Info Manager, but the changes are lost when 
you exit.

RUN THE DEMO PRESENTATION
The demo presentation discusses four applications you might develop 
using multimedia.  Run this presentation to see how easy it is to work 
in Open!Info Manager.

1.  Choose Open from the File menu.
The database can contain multiple presentations at once.  Therefore, 
you tell Open!Info Manager which one you want to work with by 
opening that presentation.

2.  Highlight Multimedia Applications Demo in the dialog box, then 
choose OK.
Open!Info Manager generally displays the Summary and Diagram windows 
for this presentation.  If either window does not appear, choose its 
name from the Window menu to display it.

The Summary window shows a textual representation of the 
presentation, listing the pages, templates, and media objects it 
uses.  The Diagram window shows a graphical illustration of the page 
flow, similar to an organization chart.

3.  Choose Preview from the File menu.
Open!Info Manager displays the first page of the presentation.  In 
this presentation, it is a menu page.

4.  Click the area over one of the option names to move through the 
presentation.  

A small hand appears when the mouse pointer is over a button that can
be clicked.

Click 1 - Dazzling Business Presentations to see how multimedia can 
dress up a business presentation.

Click 2 - Interactive Advertising & Marketing to see how you can 
really show off your products with a multimedia presentation.



Click 3 - Point of Information or Sales Kiosks to learn how Open!Info
Manager lets you add impact to a kiosk application.

This portion of the demo contains video clips.  Notice the added 
impact video brings to your multimedia creations! As you look through
this sequence, give particular attention to the whale video.  This 
TrueMotion-S video clip shows off the clarity and quality of this 
compression type.

Click 4 - Corporate Communications to find out how multimedia can 
improve corporate communications.

5.  Click the different buttons on each page to see their effect, and
to navigate through the entire presentation.

6.  Click the Exit button to exit the presentation when you finish.
You’re back in the Open!Info Manager window.  That’s how easy it is 
to open and view a presentation created in Open!Info Manager.

CREATE A PRESENTATION
Use the following instructions to create a complete presentation from 
start to finish.  This presentation will contain only two pages that 
illustrate and describe dolphins.

The first page will start with a picture of dolphins.  The viewer can 
click a button to display a text description of dolphins, or a different
button to show another picture.  A button for moving to the next page 
and an exit button complete the first page.

The second page will show a video of dolphins swimming.  It will include
buttons the viewer can click to play, pause, and resume the video.  
Finally, it will include an exit button and a button for returning to 
the previous page.

Start a New Presentation
Starting a new presentation closes any other presentation that might be 
open, and lets you start fresh.

1.  Choose New from the File menu.
Open!Info Manager displays the Presentation Properties dialog box for
the new presentation.

Open!Info Manager always supplies a default name for each new element
you create.  This default name consists of the object type 
(Presentation in this case) followed by a number, which is based on 
the total number of objects in the database.

2.  Enter My First Presentation to replace the default presentation 
name.



3.  Set the Width to 640 and the Height to 480.
The Width and Height fields are special.  These values are set when 
you first create the presentation, and cannot be changed later.  A 
presentation whose page size is 640 x 480 can be displayed on any 
monitor.

4.  Leave the other property settings at their default values.  
Notice that you cannot set the Start Page (the button is dimmed) 
because no pages have been created for the presentation yet.

5.  Choose the OK button to accept the entries.
Open!Info Manager displays a Summary window and a Diagram window for 
the new presentation.  Remember, the Summary window displays a 
textual representation of the presentation, and the Diagram window 
displays a graphical illustration of the presentation flow.  Right 
now there is no information to display in these windows.

6.  Double-click in the Diagram window to create a new page icon and 
display its Page Properties dialog box.

NOTE: If the Page Properties dialog box does not appear, choose Page 
from the Properties menu.  Also, choose Preferences from the 
Properties menu, then check to make sure the Show Template/Page 
Properties automatically option is selected in the Preferences dialog
box.

7.  Enter First Page as the Name, and choose OK.
Right now the Name is all you need to enter.  Later you’ll be setting
other properties for this page.

The Page Properties dialog box closes and the Diagram window returns 
showing a page icon titled First Page.  This icon is green to 
indicate that Open!Info Manager has set this as the start page.

8.  Double-click again, to the right of the first icon, to create 
another page.  Give it the name Second Page, and choose OK.
Notice that the page icons appear at the location of the pointer when
you double-click.

Define Content for the First Page
Next you’ll add the controls and media that make up the content of the 
first page.

1.  Place the pointer over the First Page (the green icon) and 
double-click to display its Page Properties dialog box.

Notice that the Template button is dimmed, as are all the check boxes
for using the template settings.  That’s because no templates have 
been defined for this presentation.



2.  Click the Background button.
The Background Image dialog box appears.  If the Show Information 
check box is selected, the bottom section shows a preview of the 
highlighted image, as well as information about the media file.  When
you select a different image, its information will appear.

3.  Enter stucco in the Text field and click the Find button.
Open!Info Manager searches for all image names that contain the word 
stucco, and removes all other images from the selection list.  There 
is only one image containing the word stucco.

4.  Select the image called BG: Gray artistic stucco, and choose OK.
The Page Properties dialog box returns, showing the name of the 
selected background image, and its check box is selected.  The check 
boxes let you switch between the page setting and the template 
setting if a template is being used.

You won’t be setting a transition or page sequence for this page, so 
you can ignore these sections for now.

5.  Choose the OK button to close the Page Properties dialog box.
When the Page Properties dialog box closes, the Page window opens 
showing the selected background image.

6.  Maximize both the Open!Info Manager window and the Page window by
clicking the maximize button (an arrow pointing up) in the upper 
right corner of each.

This enlarges the Open!Info Manager window to fill the screen, and 
the Page window fills the Open!Info Manager window.

Create Movement Button Controls

Movement Button Controls define areas the viewer can click to move from 
page to page through the presentation, or to exit the presentation.  The
First Page includes one Movement Button Control for moving to the next 
page and one for exiting the presentation.

1.  Choose Create Movement Button from the Mode menu to activate the 
Create Movement Button Mode.

The mouse pointer becomes a crosshair.

2.  Place the crosshair near the bottom left side of the window, 
where the status bar reads approximately X 0, Y 439.
If necessary, use the scroll bars to move the bottom left portion of 
the page into the window.

3.  Hold down the mouse button as you drag out a control box down and



to the right, about the size of the button graphics you saw in the 
demo presentation.

The status bar shows the width and height as you draw.  Don’t worry 
about drawing it an exact size.  You’ll have a chance to adjust the 
size later.

The Movement Button Properties - Page dialog box appears when you 
release the mouse button.  The Page designation in the title 
indicates that you are working on a Movement Button created for the 
page.  Different designations appear when you are working in a 
template (Global) or modifying a global control for a page (Local).

4.  Enter Exit Button as the control Name.
5.  Enter 0 as the X value and 439 as the Y value, if needed.
The X and Y values indicate the position of the top left corner of 
the control.  X is the number of pixels from the left side of the 
page; Y is the number of pixels down from the top.

You do not need to enter the Width and Height for the control.  Later
you’ll have Open!Info Manager automatically resize the control box to
fit the graphic it displays.

6.  Click the Primary button.
The Button Image group on the Movement Button Properties dialog box 
gives you fields for selecting an image to display in the control 
box.  The Primary image is the image that appears constantly while 
the page is displayed.  A different image can appear briefly while 
the viewer clicks the mouse button, depending on the Selection Effect
you choose.

When you click the Primary button, Open!Info Manager displays a 
dialog box for selecting the primary image.  This dialog box looks 
like the one you used to choose a background for the page.

7.  Use the scroll bars or the Find button to select the image titled
Button: Silver “Exit”, then choose OK.
8.  Click the Resize Control to Fit button in the Movement Button 
Properties dialog box.

This adjusts the size of the control box so it is the same size as 
the image.  Notice that the Width and Height values change 
appropriately.

9.  Be sure Flash is selected as the Selection Effect.
Usually Flash is selected by default.  It causes the image to change 
colors briefly when a viewer clicks the button.

Notice that the Selected button is dimmed.  It is available only if 
Show Image is chosen as the Selection Effect.

10.  Choose Exit in the Movement Type list.



When a viewer clicks a button whose Movement Type is Exit, the 
presentation closes.

11.  Choose OK to close the Movement Button Properties dialog box.
12.  Repeat steps 2-9 to create another Movement Button Control with 
the following settings.

Name:  Next Button
X:  553
Y:  439
Primary Image:  Button: Silver “Next”
Resize Control to Fit:  Click this button
Movement Type:  Go to Page

When you choose Go to Page as the Movement Type, you also need to 
select a destination page: the page that will appear when a viewer 
clicks this button.

13.  Click the Page button.
The Destination Page dialog box lists all pages created for the 
presentation.

14.  Select Second Page as the destination for this button, and 
choose OK.
15.  Choose OK to close the Movement Button Properties dialog box 
when the entries are complete.

Create a Display Media Control

Display Media Controls display the media that represents the content of 
your presentation.  One Display Media Control is needed for the First 
Page of this presentation.

1.  Click the Create Display Media tool (cyan button with a small 
fish) on the toolbar to activate the Create Display Media Control 
mode.

You can activate any mode either by choosing its command from the 
Mode menu, or clicking its tool on the toolbar. Hold the pointer 
briefly over any tool to see a description of that tool.

2.  Draw a large control box in the center of the page.
After you release the mouse button the Display Media Properties 
dialog box appears.

3.  Set the Name and position (X and Y) as shown below.
Name:  Picture/Text
X:  152
Y:  86



It is not necessary to set the Width and Height.  You can use the 
Resize Control to Fit button to set the final size.

4.  Click the Media button to choose the media that will appear in 
this control when the page first displays.

The Select Media to Assign dialog box appears.

5.  Choose Images from the Available Types list.
This filters out all other media objects (animation, sound, video, 
and text).  The selection list now contains only media objects for 
image files.

6.  Choose Kiosk: Dolphin Graphic 1 from the list, and click OK to 
close the selection dialog box.

7.  Click the Resize Control to Fit button to adjust the control size
to match the image size.

You need not change the Play Continuously setting.  This option 
affects only playable media: animation, sound, and video, whether 
that media is assigned directly in the Display Media Control or 
placed there by a Behavior Button Control.  When Play Continuously is
selected, Open!Info Manager automatically plays the media over and 
over while the page is being viewed.

8.  Choose OK to close the Display Media Properties dialog box when 
the entries are complete.

Create Behavior Button Controls

Behavior Button Controls let you alter the behavior of a single Display 
Media Control so it displays different media, depending on which button 
the viewer chooses.  The two Behavior Button Controls on this page let a
viewer replace the original dolphin image with either some text 
discussing dolphins or a different dolphin illustration.

1.  Activate the Create Behavior Button Mode.
Use either the Mode menu or the Create Behavior Button tool (the 
"magic wand" button) on the toolbar.

2.  Draw a small control box below the Display Media Control, giving 
it the properties listed below.

Name:  Show Text Button
X:  200
Y:  375
Primary:  Button: Silver “Text”
Resize Control to Fit:  Click this button
Selection Effect:  Flash

3.  Click the Links button.



A Behavior Button Control modifies the behavior of one or more 
Display Media Controls.  Linking is the process of identifying which 
Display Media Controls are affected.

After you click the Links button, the Link Properties dialog box 
lists the Display Media Controls defined for this page.

4.  Highlight the Picture/Text entry and click the Set button.
This displays a dialog box for selecting the media object that will 
appear in the selected Display Media Control when a viewer clicks 
this Behavior Button.  

5.  Choose Kiosk: Dolphin Text from the list.
You can scroll through the list, enter part of the name and click the
Find button, or use the Available Types field to filter out all non-
text media objects.

6.  Click OK to select this media and close the selection dialog box.
When the Link Properties dialog box returns, the selected Display 
Media Control is highlighted and the linked media is identified at 
the bottom.

If multiple Display Media Controls were defined for the page, you 
could link additional controls to this same Behavior Button Control. 
Clicking the Behavior Button would then change the behavior or all 
linked controls at once.

7.  Click OK to close the Link Properties dialog box.
The Behavior Button Properties dialog box shows that you established 
one link for this control.

8.  Click OK to close the Behavior Button Properties dialog box.
9.  Draw another Behavior Button Control box to the right of the Show
Text Button, and give it these properties.

Name:  Show Picture Button
X:  320
Y:  375
Primary:  Button: Silver “Picture”
Resize Control to Fit:  Click this button
Selection Effect:  Flash
Links:  0 Items Linked to Control

10.  Click OK to accept the entries and close the dialog box.
As an alternative to setting links through the dialog box, this time 
you will link the Behavior Button to the Display Media Control 
graphically, with the Link Mode.

11.  Click this new Show Picture Button control to select it.



Small black blocks, called handles, appear when the control is 
selected.

12.  Activate the Link Mode by selecting Link from the Mode menu or 
clicking the Link Mode tool.
Notice that a solid border appears around the selected control to 
indicate that you are setting its links.

13.  Move the pointer over the Display Media Control that shows the 
picture of dolphins.

Notice that the pointer’s shape changes to a link symbol.  This 
indicates that you can link to the control.

14.  Right-click over the Display Media Control, then choose Set 
Media from the popup menu.
A dialog box lists the available media.

15.  Select Kiosk: Dolphin Graphic 2 from the list, and close the 
dialog box.

The selected image appears in the Display Media Control to indicate 
that this image is linked to the Behavior Button Control.

Preview the First Page
Congratulations! You’ve defined all the content for the First Page.  Now
let’s preview the page to see how it looks.

1.  Right-click anywhere in the Page window, and choose Start Preview
from the popup menu.

Open!Info Manager presents the page you just created.  Notice that a 
picture of dolphins appears, with the title Dolphins.

2.  Click the Text button to display text in place of the picture.
3.  Use the scroll bar to move through and read the text.
4.  Click the Picture button to display a different picture of 
dolphins in place of the text.

The Text and Picture buttons are the Behavior Button Controls.  
Notice how they alter the behavior of the Display Media Control by 
displaying different media.

We’ll ignore the Next button for now, since you have not defined any 
content for the second page.

5.  Click the Exit button to close the preview and return to the Page
window.

If you clicked the Next button to display the second page, press 



Alt+F4 to exit the presentation.  You can also right-click anywhere 
in the blank area and choose Exit from the popup menu.

Define Content for the Second Page
As you define the content for the second page, you’ll learn a few 
different techniques, like copying controls from one page to another.

1.  Choose Modify from the Page menu, or click the Modify Page tool 
on the toolbar.

2.  Choose Second Page from the selection dialog box, and click OK.
The Page Properties dialog box appears showing the page name you 
assigned when you created the page in the Diagram window.  If the 
dialog box does not appear automatically, double-click anywhere in 
the page window.

3.  Click the Background button.
4.  Enter stucco in the text field, then click the Find button in the
Background Image dialog box to assign BG: Gray artistic stucco as the
background for this page.  

5.  Choose OK to close the Background Image dialog box and return to 
the Page Properties dialog box.

Background is the only property you’ll be setting for the page at 
this time.  The other options in this dialog box are described 
briefly below.

Template button lets you attach a template to the page to provide a 
basic layout.  It is dimmed because no templates have been created 
for this presentation.

Startup Transition lets you choose a special visual effect for 
drawing this page during viewing, such as randomly drawing a few 
segments (blocks) at a time.

Page Sequencing lets you select a next page to appear automatically 
after this page remains idle for a specified time.

6.  Choose the OK button to close the Page Properties dialog box.
After the Properties dialog box closes, the background image appears 
in the Page window.

Create Movement Button Controls

The Second Page also contains two Movement Control Buttons: one for 
returning to the First Page and one for exiting the presentation.  This 
time you’ll copy the buttons created for the First Page because they are
so similar.



1.  Activate the window that shows First Page by choosing it from the
Window menu, or clicking anywhere in that window if it is visible.

You can also activate the window by choosing Modify from the Page 
menu and selecting First Page from the dialog box.
2.  Click the Exit Movement Button Control to select it.
3.  Press Ctrl+C to copy this control to the Clipboard.
This step illustrates the keyboard shortcut for the Copy command on 
the Edit menu.  Many Open!Info Manager commands have keyboard 
shortcuts.

4.  Click anywhere in the Second Page window and press Ctrl+V to 
paste the Exit button from the Clipboard.

Open!Info Manager duplicates the control on the Second Page, giving 
it a new name (Exit Button - 2), but retaining all the other 
properties.  

5.  Scroll to the bottom of the screen, and place the pointer over 
this copied control; notice the information that appears in the 
status bar. Because this button will look and behave exactly like the
one on the First Page, no further changes are required.

Copying controls within a presentation saves time.  You only have to 
change the properties that are different, not start over from the 
beginning.

6.  Copy the Next button from the First Page to the Second Page.
Because this is a duplicate of the original, it is given the name 
Next Button - 2, and is set up with Go to Page as the Movement Type, 
and Second Page as the destination.  In this case, however, you want 
the button to return the viewer to the previous page, so you’ll need 
to change its properties.

7.  Right-click over the Next Button - 2 control (scroll to show it, 
if necessary), and choose Control Properties from the popup menu.
8.  Change only the properties listed below.  The other properties 
should remain as they were defined in the original button.

Name:  Back Button
Primary Image:  Button: Silver “Back” 
Resize Control to Fit:  Optional 
(this image is the same size as the Next button image, so there
should be no change in size)

Movement Type:  Back
When a viewer clicks a button whose Movement Type is Back, Open!Info 
Manager automatically goes back one page through the presentation.  
You do not have to choose a destination page, so the Page button is 
dimmed.

9.  Choose OK when the properties are complete.



Create a Text Overlay Control

The title Training that will appear at the top of this page is created 
with a Text Overlay Control.  You can place individual lines of text 
onto a page, selecting the font and other effects.

1.  Create a Text Overlay Control by choosing Create Text Overlay 
from the Mode menu, or the Create Text Overlay tool.
2.  Scroll to the top of the page and draw a control box near the top
of the page.  Make it the full width of the page.

When you want to center text on a page, draw the Text Overlay Control
box the full width of the page, then choose Center alignment.  This 
assures that the text is centered on the screen during viewing.

3.  Enter the properties listed below.
Name:  Title Text
X:  0
Y:  45
Width:  640
Height:  45
Text:  Training
Align:  Center
Border:  Deselected (no X appears)
Shadow:  Deselected (no X appears)

You should set the desired Width and Height for a Text Overlay 
Control because there is not an image for resizing.

4.  Click the Font button and select the font settings shown below.
Font:  Arial
Font Style:  Bold
Size:  28

5.  Choose OK to accept your settings and close the dialog box.
6.  Click the Colors button in the Text Overlay Properties dialog 
box, and choose Black from the Basic Colors section of the +Color 
dialog box.

7.  Choose OK to close the Color dialog box and return to the Text 
Overlay Properties dialog box.

8.  Choose OK to accept the properties and close the Text Overlay 
Properties dialog box.

Create a Display Media Control

The focal point of the Second Page is a video in the center.  Create a 
Display Media Control for the dolphin video.



1.  Use the Create Display Media tool from the toolbar to create a 
Display Media Control below the Text Overlay Control.

2.  Set the properties listed below.
Like before, you can leave the Width and Height unchanged and use the
Resize Control to Fit button to set the proper size.

Name:  Display Video
X:  196
Y:  144
Media:  Kiosk: Dolphin Video
Resize Control to Fit:  Click this button
Play Continuously:  Deselected 

(the video will play once and stop unless the viewer clicks a
Player Button Control)

3.  Choose OK to close the Display Media Properties dialog box.
Notice that the control box has become solid blue.  This indicates 
that media has been assigned to the control.  Since the assigned 
media is a video, not an image, it does not appear in the Page 
window.

Create Player Button Controls

Player Button Controls regulate the playback of playable media, such as 
video, sound, or animation.  The three Player Button Controls on this 
page are used to: a) replay the video starting at the beginning, b) 
pause the video, and c) restart the video from where it stopped.  

1.  Choose Create Player Button from the Mode menu, or click the 
Create Player Button tool on the toolbar to activate the Create 
Player Button Mode.

2.  Draw the first Player Button Control on the left beneath the 
Display Media Control (scroll down if needed).

3.  Enter Replay as the Name, 157 as the X position, and 335 as the Y
position.

4.  Choose Button - Silver Replay as the Primary Button Image, then 
click the Resize Control to Fit button.
5.  Be sure the Selection Effect is set to Flash.
6.  Choose Replay as the Playback Action, because Replay always 
starts at the beginning of the video.  

The Play option continues the video from where it stopped.  You’ll 
use that for the last Player Button Control.

7.  Click the Links button to display the Link Properties dialog box.



8.  Highlight the Display Video control name in the list, and click 
the Set button.
An asterisk (*) appears beside the control name in the list, and the 
bottom of the dialog box shows Link: Established.  

If there were multiple Display Media Controls defined for the page, 
you could link additional controls to this same Player Button 
Control.  Clicking the Player Button would then restart all the 
linked controls at once.

9.  Choose OK to close the Link Properties dialog box.  
Notice that the Player Button Properties dialog box shows how many 
links you established.

10.  Choose OK to close the Player Button Properties dialog box.
11.  Draw another Player Button Control beside the first, with the 
following properties:

Name:  Pause Button
X:  263
Y:  335
Primary: Button: Silver Pause
Resize Control to Fit:  Click this button
Selection Effect:  Flash
Playback Action:  Pause
Links:  0 Items Linked to Control

12.  Close the Player Button Properties dialog box.
Now you will use the Link Mode to link this Player Button to the 
Display Media Control graphically.

13.  Click the new Player Button Control to select it.
14.  Activate the Link Mode with the Link command on the Mode menu or
the Link Mode tool.
The Display Media Control shows diagonal lines to show that it has 
not yet been linked to the selected Player Button Control.

15.  Move the pointer over the Display Media Control and click the 
right mouse button.

16.  Choose Set Link from the popup menu.
The Display Media Control becomes solid blue to indicate that it has 
been linked.

17.  Activate the Create Player Button Mode again.
18.  Create the third Player Button Control to the right of the first
two, with the Properties listed below.

Name:  Resume Button



X:  369
Y:  335
Primary: Button: Silver Resume
Resize Control to Fit:  Click this button
Selection Effect:  Flash
Playback Action:  Play

19.  Link this Player Button Control to the Display Media Control 
using either the dialog box or the Link Mode.

Preview the Presentation
Now use the Preview command to view your work.

1.  Choose Preview from the File menu.
Open!Info Manager displays the page designated as the Start Page.  
Open!Info Manager automatically assigns the first page you create as 
the Start Page.  You can change it, but that was not necessary for 
this presentation.

2.  Click the Text and Picture buttons to see the changing media on 
the first page.

3.  Click the Next button to display the Second Page.
Notice that the video automatically begins playing when the page 
appears.  If you had selected the Play Continuously option, it would 
play over and over until the viewer clicked a Player Button Control 
or moved to a different page.

4.  Click the buttons below the video to stop, play, and restart the 
video.

5.  Click the Back button to return to the First Page.
6.  Click the Exit button on either page to close the preview and 
return to the Page window.

Congratulations! You’ve completed your first Open!Info Manager 
presentation.  As you've seen, it's easy to create exciting, multimedia 
presentations with Open!Info Manager. You do not have to learn a 
complicated scripting language, as you do in many other, more expensive 
authoring packages.

In addition, Open!Info Manager's simple presentation publishing feature 
lets you create distributable multimedia titles that are easy to play 
with Open!Info Reader, the royalty-free runtime program that comes with 
Open!Info Manager.


